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INTRODUCTION

This document describes how to use an AC probe (PRBT-ECT-BBAC) with Magnifi® Go 4.5 on
a Reddy® AC test instrument.

The following information was generated using the AC probe, but the same principles apply to
ECT bobbin probes.

EQUIPMENT

Eddyfi's AC probes are detachable and can be used with a HDPE or a LLDPE cable. These cables
include two 4-pin connectors that can be connected on a Reddy AC instrument. An adaptor
(PRBT-ADAPT-41xAC) is also available to connect this probe to the 41-pin connector of an
Ectane® instrument.

Depending on the manufacturer, air conditioner tubes can have inside and/or outside diameter
fins. Dimensional specifications sometimes include the fins, but not always. The most important
information for probe selection is the inside diameter of the tube (probe diameter selection)
and the root thickness (probe frequency selection).

Because AC probes need to fill an optimal portion inside the tube, their diameters are offered
from 11.0 to 23.0mm by steps of 0.2mm. It is recommended to select a probe diameter with a
fill factor around 88%. The following formula can be used to calculate the diameter that meets
this fill factor:

diameter = 2 x\/0.88 x (tube inside diameter/2)?

Select the standard probe that is closest to the result of the above formula. For instance, with
a tube ID of 14.65mm, the formula result is 13.74mm. Therefore, a 13.8mm probe should be
selected for optimal fill. When possible, we recommend keeping a lift-off around the probe
between 0.3mm and Tmm.

The right probe frequency can be selected based on the following table.

Table 1 - ECT-BBAC probes frequency range selection table

TUBE WALL THICKNESS (BWG, mm, in)

BWG 10 11 12 13 14 15 16 17 18 15 20 21 22 23 24
mm 3.4 3.05 2.77 2.41 21 1.83 1.65 147 124 107 0.89 0.81 0.71 0.65 0.56
in 0.135 0.120 0.10% 0.095 0.083 0.072 0.065 0.038 0.045 0.042 0.035 0.032 0.028 0.025 0.022
Copper UF UF UF UF UF UF UF UF UF UF UF UF LF LF LF
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Table 2 - ECT-ACTX Frequency range

CODE FREQUENCY IN kHz
Min. Max. Central

UF 1 10 5

LF 10 100 50

The AC calibration tube used in this document includes the following flaws:

* Internal groove, 10% wall loss

* External groove, 20% wall loss

*  Hole, 100% wall loss

* OD Flat Bottom Hole (FBH) at 40%, 60% and 80% depth
*+ OD 4 x FBH 20% depth

However, other combinations of flaws can be used to calibrate the probe and build sizing curves.
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PROJECT AND INSPECTION FILES

In this section, we create a folder structure that manages the saving location of your setup,
data and report. This management is operated through the creation of a Project.

Magnifi Go suggests two levels of files. The first level is the Project. It should include different
inspections that are related in some way. For instance, it can include all the inspections done
at a refinery shutdown and be named Refinery_Shutdown_May_2019. The second level of files is
the Inspection folder. Inspection folders are saved in the project file. An inspection folder can
include the data specific to the inspection of a tube bundle with a specific technology and could
be named Copper_075x0.065_AC, for instance. This inspection folder groups the setup, the tube
list, the data files and the Magnifi Go report.

PROJECT
(ex: Refinery 04-17)

|
INSPECTION 1
(ex: Bundle No A1D3FX)

I E— ﬂ | |

INSPECTION 2 INSPECTION X

SETUP
TUBE
LIST

l_l

|

|

|

|

|

|

|

|

|

|

|

:

| <«—> DATA
|

|

|

|

|

|

| REPORT
|
|
|

When you open Magnifi Go, the first page displayed is called the backstage.
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General

Inspection Information

General Probe Model: PRBT-ECT-BBST

Project Folder:  Default
Tube Dimensions:

oD:  19.05mm
WT: 0.89 mm
Setup / Data Length: 500 mm

Report Summary Setup Loaded:  Default setup B Material: Copper

Inspection: Default

Acq. Summary

Create Frequencies: 12.8,6.4,32, 0.8 kHz
Data Loaded:

Acquisition

Filename: Row, Col ¥ L?| —
Material Database = O

Create New| -
001001.magdata g Import List
Documentation Report
Table Profile: | Tubing ECT/Array ¥ 5 5
. seows | [ B | [ B _
Preferences Generate Export
Take screenshot with report entry Report Report

>

Start/
Resume

To create or open a project, click the ellipsis next to the project folder textbox in the backstage.
You can select an existing project/folder or you can create a new folder.

1. Create a folder by clicking the Add button and enter the chosen name or select an
existing folder. The chosen folder is highlighted in blue. Once the correct folder is selected,
click the Select button.

1] Manage

r Projects
o Manage Projecls
Name

Default

New project |E

Add |/ select | [ close

2. Click the ellipsis next to the inspection textbox in the backstage, then click Add and enter
the name of your inspection.
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/] Manage

r Inspections

o Manage Inspections

Name State

Default | b 4

Bundle_A_Copper_0.75X0.028_AC| ‘-

] [

3. Hit Select. This defines the position where the setup(s) and data are saved.
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SETUP WIZARD

In this section, we show how to create a setup using the Setup Wizard in Magnifi Go.

Before proceeding, you can change the measurement unit. To do so, click Preferences. In the
System tab you can change the measurement units from metric to imperial and vice versa. For
the metric units, you can choose meters, centimeters, or milimeters in the General tab. For
imperial units, you must use inches. When finished, click Preferences again to return to the

General window.

System

Preferences

Measurement Convention Measurement Units.

[»

General

Automatic Features

‘ Aliow to save setup in onginal location

Display

Reminder to save setup after acquisition if not saved yet

Analysis

Logo
Py ) Preview:
' . Y
. .
' () edd
Select
Company Logo
Shortcuts Date and Time
Keyboard Tuesday, 19 February 2019 08:21:53
Remote

© ASME @ Metnic
System () Ase invertea 32@- --@ O impera
O EDF

Preferences

Syslem

General

Display

Analysis

General

Measurement Units

Report Units: | Milimeter

Channels
Full Channel Scale: 2000Vpp o

|Z| Hide Raw Channel

Precision
| Enable
Amplitude: 2 decimal plac. 5
Phase: 1 decimal plac.
Acqusiton
|,/ Automatic File Recording

|./ Automatic Next on Stop acquisition

| Keep re-scan files

To create a new setup, you can use the Setup Wizard process. Click Create Setup to

Setup Wizard.
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COMPONENT DEFINITION

The first page shown by the Setup Wizard is the Component Definition.

Select the Air Conditioner option, then click the Material field to open a scrolling menu. Select
the material of the tube to be inspected.

Ve New Setup Wizard

Application: O Generic @ Air Conditioner

Component Definition -

Configure the geometry and material of the component to inspect

Material: Copper Y
‘ v : -
Wall thickness: 0.028in =
22
' BWG
| 1 1 1 1 1 1 ] 1 1 1 1 | 1 1 1 Y 1 1
6 24
Outside diameter: 0.750in =1
Length: 236.22in =

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the
slider. Note that the wall thickness value excludes the fins. Enter the tube outside diameter and
length.

These tube properties help Magnifi Go suggest the optimal scan parameters.

Click Next when everything is set correctly.
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PROBE SELECTION

In the Probe Selection window, select the probe you are using for your inspection.

Select Bobbin ABS-DIF + AC probe the Eddyfi’'s AC probe.

2 New Setup Wizard

”\./ Probe Selection -
.J Select the probe that you want to use for your inspection
w

Technigue ‘ ECT v Model: Al &
Probes
Tech Model Catalog Number Description

Baobhin Bobbin ABSIDIF ECT standard bobhin probe, ABS/DIF

‘x Cancel ‘ ‘ ‘ Back ‘ ‘ ’ Mext
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DATA DEFINITION

The Data Definition window is used to set the hardware gain, frequency and drive voltage for
the Absolute, Differential and AC channels. It is important to set these parameters correctly
before acquiring data since they are driven by the instrument and cannot be modified during

the analysis.

> New Setup Wizard
ﬂ Data Definition _

. Select the channels you will be using and the necessary frequencies

Channels Required frequencies
Name Prefix Gain (dB) Prefix Yal (kHz) Ampl )
Differential - 1 D1- 438.0 F1 |24 5.00 g
Absolute - 1 Al- 48.0 F2 1z 5.00 g
AC-1 ACT- 48.0
D Differential - 2 D2- 28.0
D Absolute - 2 A2- 28.0
[j AC-2 AC2- 28.0
Suggest

‘x Cancel ‘ ‘ ‘ Back ‘ ‘ ’ et ‘

By default, Magnifi® Go suggests four frequencies theoretically calculated with the parameters

previously entered:

Prefix Frequency
F1 2 x F90
F2 F90
F3 F90/2
F4 F90/8
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Frequency and drive voltage can be changed by replacing their values in the Required
Frequencies table. Up to four frequencies can be set at the same time. The sum of their
amplitude cannot exceed 10V.

Ensure that the frequencies are within the probe limits found in Table 3. If one of the suggested
frequencies is not within the recommended probe frequency range, you can either remove it by
clicking the X or update it to the recommended range.

Note that a second set of channels, labeled with “-2”, is available for the AC probe. By default,
these channels have a lower gain and can be used in land areas to get data where the first set
of channels are saturated.

Click Next after the desired parameters are entered.

DISPLAY

The first Display window is used to configure how data displays during and after acquisition.

7 New Setup Wizard
Display ]

Configure display and layout properties

General options Lissajou / Strip chart options

Zoom behavior on stop acquisition:
= Display Direction: Top to Bottom

R i

\J/I Zoom to full scale

Strip chart duration: 71 0s -

1 conce | | Bax H_’ Next
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The display direction is the direction in which data appears on the screen.
The strip chart duration is the length of a Strip chart window when the data is acquired.

Click Next.

The second Display window is used to set the layouts. Selecting the proposed layouts makes
them available in your setup. You can switch from one to another via the layout tab. The "S"
stands for Strip chart, "L" for Lissajous and “C" is the defect Code indication zone.

The blue background layout is the one opened by default.
Layouts can be readjusted at any time.

7 New Setup Wizard
Display ]

Select the layout that you want to use to display your inspection results

2 Strip charts, 2 Lissajous ‘ 2 Strip charts, 4 Lissajous
L L L
L L L
3 Strip charts, 3 Lissajous pyramid 3 Strip charts, 4 Lissajous

[ : Default layout

(o cancel | | Bak | [/ Finish

Click Finish to complete the Setup Wizard process.
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SETUP MODIFICATIONS

Some parameters or preferences can be modified after the Setup Wizard process. Go to the
Setup tab in the Frontstage and click the button associated with the parameter you want to
change.

Home Setup ‘ Calibration Layout Current View

oA S B §F o B A A S E

Comp Probe Scan Data Process Landmark PC'aIt Calibration Sizing Indication Display
oints

The Comp, Probe, Data and Display buttons opens one for the windows previously described.

Other parameters are available via the Scan, Process, Landmark, Cal Points, Calibration, Sizing
and Indication buttons. Change the desired parameter. If applicable, go through the process
by clicking Next, and then click the Finish button. This applies the modification to the setup.
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SCAN DEFINITION

The Scan Definition window is used to configure the axial position measurement method, the
acquisition rate and the typical probe speed.

P Edit Setup Wizard

Scan Definition

Configure the type of scan you will be performing with your probe

Scan: Single Pass
Position from: Clock N
Acguisition rate: 2000 Hz -
Typical probe speed: |1000.0 mrmfs
Acquisition Size: 600.000 5 -

The position along the tube can be defined by using either the system’s internal clock or an axial
encoder. If you use the internal clock, the default position assumes that the probe is always
pulled at the typical probe speed. If the typical probe speed is set to 300mm/s, and the time
since the acquisition was started is two seconds, the system will indicate a position of 600mm.
Using an encoder gives you the exact position of the probe. Note that the position can also be
obtained by using the landmark, but this feature is shown later.

The acquisition rate is the number of acquisition points taken per second. By default, the
acquisition rate is set to 2000 Hz for the AC probe, but depending on drive frequency used to
inspect, the actual acquisition rate may differ. The system automatically readjusts this value
as needed. For standard AC probes, the acquisition rate can always be set to 2000 Hz.

The axial resolution depends on the combination of the acquisition rate and pulling speed. For
an acquisition rate of 2000 Hz, the pulling speed needs to be less that Tm/s to have at least two
points per millimeter. If the probe is pulled manually, the pulling speed won’t be constant.

17|Page



Therefore, it is recommended to target a lower pulling speed to be able to reach your axial
resolution target. Also, typical probe speed should be set as close as possible to the real value.
This helps the algorithm that automatically detects landmarks (explained later). The
recommended pulling speed for the AC probe is around Tm/s.

If you selected the position from Encoder, different fields appear and a second Scan Definition
page becomes available.

it S Wizsrs it e Wizard

Scan Definition Scan Definition
e Configure the type of scan you will be performing with your proba e Encoder and axis settings
e Avial Encoder
Fusition from: Encoder - Type: Quadratire

[ZJ Detect Dverspeed Resolufior | 25.460 % countmm
Typical probe speed 1000.0 s - D Irwert direction
Masdmum probe spaed: | 3000.0 mmis - Frezet 0000mm o
Dersity 2,000 smplmm - M Apply preset on Start
Acquistion Size: 10000.0 rran -
i’ cocwl : P e H  canca 4 e P e

On the first page, the Typical Probe Speed, Maximum Probe Speed and the Density need to be
entered. The Maximum Probe Speed is the maximum acceptable speed for your probe and the
Density is the number of acquired points per millimeter (axial resolution). These values are used
to set the acquisition rate and optimize the acquisition processes used by Ectane. Note that if
your probe is pulled at a speed exceeding the Maximum Probe Speed, data will be lost.

The second page includes the type of encoder and its resolution. A preset can also be specified
if your acquisition doesn’t start at 0 mm.

Selecting the Detect Overspeed option highlights the maximum probe speed when pulling too
fast.

Click Next when you're finished.
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DATA PROCESSING

The Data Processing window is used to configure the signal processing to apply to the channels.

You can choose to configure every frequency individually or apply the same filters to every
channel with the Individually Configure All The Channels option.

Note that the signal processing is done after data acquisition. Wrong parameter choices for
data acquisition can mislead the analysis, but an inappropriate parameter choice can be
changed without any problem during data analysis.

7 Edit Setup Wizard

E Data Processing

Y Select the processings that you want to apply to the channels you have selected

[j Individually corfigure all the channels

Low Pass Median High Pass
Name ’ Cutoff (Hz) Window Size (smpl)
Al- [:] 400 [:] 301
ACT- [:] 400 [:] 301
O1- [:] 400 [:] 301

The low-pass filter eliminates part of the signal above a certain frequency. As an example, it is
useful when the defect signal has lower frequency content than the background noise. In this
case, using a filter removes part of the noise without removing defect signals. This may help to
analyze the data. However, a cutoff frequency that is too high won't remove much noise, and
a too low cutoff frequency filters out defect signals.

The median high-pass filter is used to filter out low frequency noise or drift such as lift-off
variations of the probe within the tube, changes in material, geometry or thickness. As a rule-
of-thumb, the width of high-pass median filter should be set at least three times of the longest
flaw that may be encountered. Data should be examined in its filtered and unfiltered states. It
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is important to keep in mind that the high-pass median filters can distort phase. More
information about median filter for NDT analysis can be found on Eddyfi’s blog.

Click Next when you are done.

DETECT LANDMARK

The Detect Landmark window is used for configuring the automatic detection of features such
as tube sheets and support plates. Landmarks are not mandatory and don’t need to be set to
have functional setup. However, they can give relevant information of the axial position in a
tube. They can also be used by the software to trigger automatic acquisition sequences.

Three landmarks are created by default. The default channel used to detect these landmarks is
the lowest frequency absolute channel. The R_ before the channel stands for Raw. This is the
signal of the channel without software filter, rotation or software gain applied.

2 Edit Setup Wizard

9 Detect Landmark
9 Configure landmarks detection

. (Exit is used for Exit
Detection Channel: R_A1-F2 N TS1 sequence only) TS2
L ]
Position From: © Start Record O Stop Record rn.l 1 I—
Stop Start
G Megative Positioning:  From 0.0 mim Record :_1 : Record
position from
Detection Engine: Legacy Length 0
Landrnark Table {in the arder seen by the probe during data acquisition)
Hame Type Pos. (mm) Min Qty MaxQty Shape  Component Threshold () P2P (mm) Enable
Exit Exit -25 b # 10000.00 Disabled @ -
TS2 TS2 0 b # 10000.00 Enabled @
TS1 TS1 BOOO b # 10000.00 Enabled @ v
Positioned Landmark
‘ Import... ‘ ‘ Export... ‘ Add

You can base the position of your landmarks either on the location where you start to record
(usually the tube entrance, opposite from the operator position) or by the place you stop
recording (usually the operator side).
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In the above example, the Exit landmark is detected when the probe exits the tube at its outer
end. It can be used to trigger the data recording (explained later). It has a negative position
because this event happens before entering the tube. It is enabled only when performing the
acquisition. This landmark is not included in the resulting data file and is not available at the
subsequent analysis step.

TS2 is the first tube sheet encountered when the probe is pulled. TS1 is the last tube sheet
encountered at the end of the acquisition. These two landmark detections are enabled during
both the data acquisition and analysis.

The landmark detection can be set manually by describing the shape, component and voltage
threshold that triggers the detection. The Shape describes the shape of the signal when the
landmark is reached. If a differential signal shape is chosen, the peak-to-peak distance (“P2P")
is also needed. Direction is the projection axis (horizontal of vertical) of the Lissajous signal used
to trigger the Landmark, and Threshold is the voltage amplitude threshold.

Landmarks can be calibrated on real signals (explained later); in this case, there is no need to
change these parameters as they are automatically measured by the software.

[t’s important to set the landmarks position as accurately as possible. If the position is not
accurately set, the software might prevent their automatic detection since it won't be at an
expected position.

The Type field is a name that associates the calibration point to the landmark. If landmarks
share the same Type, they are calibrated at the same time using the same point and process.
To associate two landmarks with the same Type, their signal must be the same. If same
geometry support plates are present in a bundle, they can share the same Type. In the above
example, TSTand TS2 don't share the same Type because one is triggered when the probe enters
the tube and the other is triggered when the probe exits the tube.

Detection Engine drop-down menu can be set to Legacy or Extended. In Legacy mode, all
landmarks must be entered with the right position. The system looks for the exact number of
landmarks entered at positions close to those entered in the table. With the Extended mode,
the system looks for several landmarks between the Qty max and the Qty min. In this mode,
the exact number of support plates doesn’t need to be constant or known.
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CALIBRATION POINTS

The Calibration Points page is used to define the points in your calibration tube. These
indications are used later to calibrate your probe and build sizing curves.

The calibration point units of measurement can be set in percentage or in depth (millimeters or
inches).

7 Edit Setup Wizard
Calibration Points
@ Configure calibration points used for channels and sizing curves

Units of measurement Percentages (%) v

Calibration points

Name Side Size
HOLE Thraugh 100.0 B
FBH-80 QD 30.0
FEH-60 QD 60.0
FEH-40 QD 40.0
4% FEH-20 ap 200
IDGR-10 ] 10.0

-
=it vy

You can add calibration points by clicking on the Add button. Specify the calibration point name,

side and size. The side and size of the flaw is used to position the calibration point on the sizing
curve(s).
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CALIBRATION

The Calibration page is used to define reference signal(s) that are used to set the amplitude(s)
and phase(s) of each channel using the selected measurement method.

£ Edit Setup Wizard

6 Calibration

/l \ Configure parameters to calibrate channel amplitude and phase

[j Individually corfigure all the channels

Armplitude Phase
Name Valtage (V) Reference Measurement Andgle (%) Reference Measurement
Al- 0.20 HOLE MP 0.0 LIFTOFF MP
ACT- 1.00 HOLE FP 0.0 LIFTOFF FP
D1- 1.00 HOLE FP 0.0 LIFTQFF FP

By default, calibration is performed on the Hole signal by putting it at 1V on both the absolute
and the differential channels, and at 0.2V on the AC channel. The phase is adjusted at 0° on
the lift-off signal. However, the calibration can be done differently on each channel type. It can

also be done individually for each frequency by selecting the Individually Configure All The
Channels option.

When you select the reference signal, the system uses the selected measurement method to
apply rotation and gain. Here are short descriptions for the available options:
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Absolute (A):

Uses a straight line from the
Lissajous origin to the main cursor
position to measure amplitude.

Absolute Horizontal (AH):

Only uses the horizontal
component, from the Lissajous
origin to the main cursor position to
measure amplitude.

. Absolute Vertical (AV):

Only uses the vertical component,
from the Lissajous origin to the
main cursor position to measure
amplitude.

. Absolute Peak (AP):

Uses a straight line, from the
Lissajous origin to the peak value of
the data selection, to measure
amplitude.

. Absolute Peak Horizontal (APH):

Only uses the horizontal
component, from the Lissajous
origin to the peak value of the data
selection, to measure amplitude.

. Absolute Peak Vertical (APV):

Only uses the vertical component,
from the Lissajous origin to the
peak value of the data selection, to
measure amplitude.

Absolute (A):

Uses a straight line from the
Lissajous origin to the main cursor
position to measure amplitude.

. Absolute Horizontal (AH):

Only uses the horizontal
component, from the Lissajous
origin to the main cursor position to
measure amplitude.
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9.

10.

1.

12

13.

14.

15.

Absolute Vertical (AV):

Only uses the vertical component,
from the Lissajous origin to the
main cursor position to measure
amplitude.

Absolute Peak (AP):

Uses a straight line, from the
Lissajous origin to the peak value of
the data selection, to measure
amplitude.

Absolute Peak Horizontal (APH):
Only uses the horizontal
component, from the Lissajous
origin to the peak value of the data
selection, to measure amplitude.

. Absolute Peak Vertical (APV):

Only uses the vertical component,
from the Lissajous origin to the
peak value of the data selection, to
measure amplitude.

Average Peak (MP):

Takes the distances from points at
the extremity of the cursor to the
peak of the data selection to build
an average vector. Only used and
recommended for absolute signals.

Average Peak Horizontal (MPH):
Uses the horizontal component of
the distance form points at the
extremity of the cursor to the peak
of the data selection to make an
average vector. Used for absolute
signals.

Average Peak Vertical (MPV):
Uses the vertical component of the
distance form points at the
extremity of the cursor to the peak
of the data selection to make an
average vector. Used for absolute
signals.



16. Peak to peak (PP): 18. Vertical (PPV):
Uses combination of the vertical Only uses the vertical component to
and horizontal components to measure the amplitude.

measure the maximum amplitude. 19. Peak to peak First Transition

17. Horizontal (PPH): (PPF):
Only uses the horizontal component Uses a combination of vertical and
to measure the amplitude. horizontal components of the first

transition of the signal to measure
maximum amplitude. The first
signal transition is from the base of
an indication to its peak.

Note that some measurement methods are only available if they are checked in the Analysis
tab of the Preferences section in the Backstage.

SIZING CURVES

The first page of this section is the definition of your sizing curves. A curve is built for each line
in this table.

£ Edit Setup Wizard

Sizing Curves

A Add and configure the sizing curves necessary for your inspection

1D Warme Source Measurement
D1-F1 D1-F1 Phase g
D1-F2 D1-F2 Phase @
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The sizing curve allows you to estimate the size of a defect based on the calibration points’

signals (amplitude or phase) obtained with your calibration standard. Magnifi Go provides the

interpolated flaw size based on the built sizing curves.

Sizing curve names are customizable. The channel source and measurement type can also be
changed. You can add sizing curves by clicking the Add button.

Click Next when you are done.

For every sizing curve created in the last window, a window appears to configure the curve

properties. The name of the curve is shown in the upper left corner of the page (D1-F1in the

example below).

Sizing Curves

A Configure the properties of the D1-F1 sizing curve

Edit Setup Wizard

Measurement method:

Shape:

[j Report as remaining wall

BFDS

Select the curve's points:

71~

MNarme Side Size
IDGR-10 ID 10.0
HOLE Through 100.0
FEH-50 oD 80.0
FEH-60 oD 60.0
FEH-40 oD 40.0
4xFBH-20 0D 20.0 i
D ODGR-60 OO 60.0
[ 1 oncran  an 400

]

‘ x Cancel

‘ ‘ ‘ Back

gl 2

Next ‘

The measurement method options are the same as those described in the calibration page

section of this document. By default, the option peak to peak is used for the differential

channels.
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The interpolation method can be selected in the Shape dropdown menu. Here are short

descriptions for the available options:

1.

Best Fit (Dual linear) (for phase measurement only):
A curve with two linear segments representing ID and OD (or Near and Far) side
calibration points in relation to phase.

Best Fit (Dual Slope) (for phase measurement only):

A curve with two segments representing ID and OD (or Near and Far) side. The ID section
is linear and the OD section is polynomial. The OD side of the curve needs at least three
points (including the hole) in order to trace a polynomial curve.

Best Fit (Polynomial) (for phase and amplitude measurements):
Best polynomial (degree 2) interpolation within the measured (at least three) calibration
points.

. Connected Points (for phase and amplitude measurements):

Simple point-to-point curve.
Best Fit (Linear) (for phase and amplitude measurements):

Best linear interpolation within the measured calibration points.

Best Fit (Dual Polynomial) (for phase and amplitude measurements):
Polynomial (degree 2) interpolation with two segments for both ID and OD side of the
curve; at least three points are needed.

The linear options are mostly used when few data points are available, while the Best Fit (Dual

Polynomial) option is a more precise method when your calibration tube has multiple defects.

Once the measurement method and the interpolation curve shape are chosen, you can select

the curve points for each sizing curve previously created. The order in which the points appear

in the list may influence your sizing curve. Make sure that the measured values of the calibration

points are in ascending order in the list. You can set Magnifi Go to show remaining wall instead

of defect size by checking the box Report As Remaining Wall Thickness.
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INDICATIONS

The Indication Codes page is used to define the entries added to the report when analyzing the
data.

When an indication is added, its abbreviation (code) is shown in the code pane next to the data.

2 Edit Setup Wizard

— Indication Codes

—
Configure the indications codes used for the report

Code Description Type Automatic Color

COR Corrosion Defact g E
CRK Crack Defect g

DNT Dent Defect g

DSl Distorted support indic  Defect g

ERQ Erosion Defect g

MDD Mo defect detected Mo indication g

OEBS Obstructed Featurs |’ Red g

PIT Pitfinn Mefact ’7‘ E

(e | [

You can modify the default Indications Codes list by changing the parameter in the table. New
indications can be defined by clicking the Add button.
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TUBE LIST

Magnifi Go saves a file for each inspected tube. The file names are defined by creating the tube
list.

This list can be created in the Acquisition section of the General tab in the Backstage.

Acquisition
Filenarme: Fow, Col = ¢ m— —
Creafe New :
001001 magdata Lict Import List

Two options are available to set the filename format:

1. Row, Col:
Row number, Column number. Mostly used for tubing inspections.

2. Zone, Row, Col:
Zone number, Row number, Column number. Mostly used for tubing inspections.

Click the Create New List button. The window display is different depending on the chosen
filename format.

For the Row, Col option, enter the number of rows, the starting row number and row interval.
Then enter the number of tubes per row in the Nb. of Columns fields of the table. Click Create
to generate the list of tube. You can also use the Create & New button to add another set of
tube to your list.

] File List Creator

File List Configuration

Number of Rews in Component: |1
Start Numbering at Row: 1

Row Interval 1

4F (O (O

MNurmber of Columns per Row:
Row Nb. of Colurnns

1 1

Column Interval 1

Include first and last column of each row

Files to Create: 1

L1

Filename Preview: 001001

Create &
‘« Create ‘ ‘x Cancel ‘
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The same principles apply to the Row, Col format.

The tube list can also be imported from another project using the Import List button. The tube
list file is found in the Inspection folder. You can also import a list created in the TubePro™
software (available from Eddyfi).

PERFORMING AN ACQUISITION

1. If you are in Backstage, move to Frontstage by clicking the Start/Resume button.

Note: If you created a new inspection project, the Acquisition Summary window will open.
The customizable fields displayed give information on the current inspection and are shown
in the Magnifi Go report (described later).

m Acquisition Summary
Component Type ~ IXl \z\
Site i IZ|
Client v Zl
Inspector N Izl
Service Provider ~ ’7‘ \z‘

Comment

‘ Reset to Default ‘ | \mpor‘t| ‘ Export ‘

‘ 0K ‘ | Cancel ‘

Two acquisition modes are available in Magnifi Go: The Setup Mode and the Acquisition
Mode. The Setup Mode is used to scan your calibration tube and make the necessary
adjustments to your setup without saving the data automatically. The acquisition mode is
used for inspection. When in this mode, the software automatically saves the acquired data
using file names based on the tube list.

2. For the calibration phase, go to Setup Mode by clicking the Setup Mode button in the Home
tab. This mode is active when the Setup Mode button is gray.

O o
o

SETUD Mull
Mode

3. Plug the probe into the two 4-pin connectors on the Reddy AC.
4. Put the probe head in a clear area in your calibration tube and balance the probe by clicking
the Null button in the Home tab or the same icon on the instrument.
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5. With the probe inside the tube, start your acquisition by clicking the Acquire button in the
Home tab or press the physical Play/Stop button on the Reddy AC.

6. Put the probe head outside the tube at a normal pushing speed.

Pull the probe until it is outside the tube.

8. When done, press the Stop button or press the physical Play/Stop button on the Reddy AC.

N

o Home Setup | Calibration Layout  Current View 'G} Wt €03 mF @m
o a BB § 9 B A A% @& [

New | Comp Probe Scan Data Process Landmark Cal  calibration Sizing Indication Display | /0 Manual
Points Sequence S
Cm— AT BN 2 ) N T O
g . ; . .
@ | |Row Gol Al-F1  17.6kHz A  D1-F1 17.6 kHz | AQ1-F2 8.8kHz | 8.8 kHz
2.51V 4.0°
vep | e |25 CoR | coR

0 total, 0 acquired

4] %o
[ %]

1 : it
M » | vmp ’ COR || Vpp ‘ ‘ COR
© Notification center Information Documentation Report
(1, . [Te AT(s) [oGm) [AGn)  [YLm(in) [Speed (n/ A
L+ 2.552 159 1100472 | 62.579 N/A 0 '

Note that a red zone in the code pane means that at least one of the raw signals is saturated.
This is usually the case when your probe is out of the tube.
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VISUALIZING THE DATA

Multiple options are available to select and measure your data. The following describes useful
functions:

DISPLAYED CHANNEL

There are three buttons at the upper left corner of the Strip charts and Lissajous windows. These
buttons are used for channel selection.

1. 2. 3.
AC1- | F2

-

1. Link Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a

Strip chart are both set to 1, setting the Lissajous to DI-F1 also sets the associated Strip
chart to this channel.

2. Click the corner with the black triangle for the list of available channels. Select the
desired channel. Click this button to switch to the channel in the list.

[ T (I

D1-

Al-F2
A1-F3
Al-F4
AC1-F1
AC1-F2
AC1-F3
AC1-F4

D1-F1

D1-F2

v

3. Same principle as 1, but for the frequencies only.

8|Page



STRIP CHARTS AXIS ORIENTATION

The Strip charts are a projection of the Lissajous on the vertical or horizontal axis. To switch
from one axis to another, click the box showing an arrow at the upper right corner of the Strip

] o [£]

~At-F1---17:6-kHz - A

/OOMING

To adjust the zoom of a Strip chart on a Lissajous, pinch/un-pinch the selected window.

ADJUSTING THE CURSOR LENGTH

On a Strip chart, the cursor is divided by three lines. The dotted lines represent the limit of your
cursor and the full line is the center of what you selected.

Only the selected section of your data is shown in the Lissajous.

To adjust your cursor length, select the Resize Cursor option and use the up/down arrow buttons
on the instrument to resize the dotted lines symmetrically.

«I-; Move Cursor

Alternatively, you can touch the E button on the desired Strip chart, using your finger to
resize the cursor.
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ADJUSTING THE SCALE

The scale of a window (Lissajous or Strip chart) can be modified by selecting the Scale option
and the up/down arrow buttons to increase or decrease the scale of the selected window.

| T |15.30v‘|ﬂ ‘ 1633V
/

D1-F1 17.6 kHz ~ | D1-F2 \ 8.8 kHz

«I—r Move Cursor

I . T A '
= 4.49Y 81.3° : 2% 4

Vpp COR )

MEASUREMENT METHOD

The buttons at the lower left corner of the Lissajous windows are used to select the
measurement method. A short description of the measurement methods can be found in the
above calibration section of the Setup Wizard.

1. 2. 3.
Vmp “pp‘g

1. Click the corner with the black triangle for the list of measurement methods for
amplitude of the signal. Select the desired method. Right or left click this button to
select the following or previous method in the list.

2. Same as 1, but for the phase measurement.

3. Remove 180° from the measured phase. This option can be used if the software doesn’t
measure the phase with the right orientation.
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LISSAJOUS ROTATION AND PANNING

The signal in a Lissajous can be rotated by clicking and holding the orientation button on the
Lissajous and dragging up or down on the screen.

| I D1- |F1‘ | 3544° Jir015v,
17.6 kHz

21.42V 210.0° ““\“ 2?

| Vmp | °pp |S-| ‘ COR | COR

Rotating the signal will affect your calibration. If you perform this operation, make sure to
recalibrate afterwards.

DATA CENTERING

To center data in different windows, put your cursor on the point you want the data to be
centered and press on the Center button in the Home tab.

o Home Setup  Calibration Layout Current View -G}

(\ 1 B =2 ro =

> '@ o — Q& TN W r(') * g
SelUp Nyl Previous Acquire S3V€ Next Re-scan FUl - Best Joonter| Save Keep = No  peyay
Mode Data Extent Fit Setup Setup | Defect

GESTURES
Gesture Representation View Effect
) Move the cursor to the
Strip chart )
tap location.
7 Center the data in the
) Lissajou view (effective in both
Single tap N[ ™ Lissajou and Strip chart).
x1
/ View top or bottom
box (like the channel | syitch to next item in the
box 7%, frequency list for that box.
box, etc.)
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View top or bottom
box (like the channel

Open the items list for

One finger scroll

Long tap
O box 77, frequency that box.
box, etc.)
Two finger scroll N Strip chart Scroll the data vertically.
4 Strip chart Move the cursor vertically.

Strip chart, after

B Resize the cursors until
tapping on the you stop touching screen.
button.

n . Scroll data in all
One finger pan Lissajou

directions.

Pinch / un-pinch

Strip chart & Lissajou

Zoom/ un-zoom data
(vertically for Strip charts,
in both directions for
Lissajou).

Gesture representations (Gestures Long Press.png, Gestures Pan.png, Gestures Pinch.png, Gestures Scroll.png, Gestures Tap.png, Gestures Two Finger

Tap.png,  Gestures  Unpinch.png)

GRPH3B18,

licensed  under CC-BY-SA 3.0,

(https://commons.wikimedia.org/wiki/Category:Multi-touch_gestures).

available  from  Wikimedia ~ Commons

The Reddy’s physical arrow buttons can also be used for finetuning data selection or cursors.
Their effects are modified depending on the choice made on the cursor effect button located

at the bottom left of the screen. This choice can also be made via the physical button.
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CALIBRATION AND SIZING CURVES

SLEW

The AC probe includes three channels: the absolute, the differential and the AC.

The coils used of the AC channel are not physically located at the same axial position as the
bobbins of the absolute and differential channels. Therefore, there is a time delay between
these channels. To bring all the signals to the same position, the bobbin channels can be shifted
in time to match the AC signal. This process is called Slew in Magnifi Go.

To Slew:

1. Click the Slew button that can be found in the Calibration tab.

[M] Slew Calibration

Select current slew:
Slew / v

Capture Positions

+

Slewvalue: 0 smpl

Apply

Close

2. Place your cursor over a flaw in your AC signal.

3. Click the button on the left in the Slew Calibration window. This sets the reference point
where the channels will move.

4. Place your cursor over the same flaw but on the differential or absolute channel.

5. Click the button on the right in the Slew Calibration window.

6. Click Apply.
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Note that this process will move the channels by a constant number of samples. Therefore, an
inconsistent probe pulling speed won't have valid data alignment for the entire scan.

CALIBRATION

The following section describes how to calibrate your probe.

1. Access the Calibration tab and click the System icon.

2. Select Channel in the Calibration window.

3. In the Strip chart, go over the signal to calibrate and adjust the cursors to view the
desired signal only.

Note: The system calibrates the signal with the measurement method defined in the calibration
part of the setup (accessible in the Setup tab). We recommend reading the data with the same
method indicated in the calibration section of the setup. This allows you to see what the system
is using to make its calibration. If for some reason the measurement is not taken properly, you
may be able to readjust your cursor to have the right measured values.

T o : xX
) .L"| Calibration -

Di-F1 [17.6 kHz A
Channel ~ ®
Exit
HOLE
LIFTOFF
____________________ TS
152
L Calibrate
Reset

4. Select the signal name in the list.

Click the green arrow button to associate the measured signal to the calibration point.

6. If more than one calibration point is present in the list, redo steps 3, 4 and 5 for all of
them.

7. When all your calibration points are selected, click the Calibrate button.

ol
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SIZING CURVES

The following section describes how to build sizing curves of the bobbin channels (Absolute and
Differential) only.

The AC signal is designed to see circumferential flaws in the tube. It also attenuates the land
area signal and allows better detection in these areas. However, the coils used to generate this
channel are configured in a way that may lead to different signal shapes for a given flaw. This
shape depends on where on the probe circumference the flaw is detected. Sizing curves for this
channel are therefore not suggested.

To build your sizing curves:

1. Go to the Calibration tab and click the Sizing Curve button.

2. Select Channel and Sizing Curves in the Calibration window.

3. Go over the signal in your Strip chart and adjust the cursors to only see the desired
signal.

Note: The system reads the signal with a measurement method that is defined in the sizing
curve part of the setup (accessible in the Sizing tab). We recommend reading the data with the
same method as indicated in this section of the setup. This allows you to see what the system
is using to build sizing curves. If for some reason the measurement is not taken properly, you
may be able to readjust your cursor to have the right measured values.

Also, when points are entered in the sizing curves, the interpolated value is displayed on the
Lissajous to show the defect size. To have the correct interpolated value, the measurement
method needs to be the same as the one used for the sizing curve. To change the measurement
method, click the icons at the bottom left of the Lissajous.

4. Select the signal name in the list.

5. Click the green arrow.

6. Redo the previous steps for all the other indications in the list.
7. Click the Calibrate button.

2 Sizing Curves

4% FBH-20

FBH-40
FBH-60
FBH-80
HOLE

IDGR-10

Calibrate

Error messages after creating the phase sizing curves may appear. The main cause for these
errors is the measurement direction.

The image below shows two different measurements. On the left you can see the measurement
arrow pointing towards the lift-off signal. In this case, the measured phase is rotated 180° from
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the correct value. When one or more points were measured in the wrong direction, Magnifi Go
cannot build the sizing curve and generates an error message. Note that you won't have this
issue with an absolute channel if you're using the average peak measurement method.

In the image on the right, the arrow points from the lift-off signal to the defect signal, which is
correct. However, in this picture, the arrow starts quite far from the middle of the lift-off
variation signal that causes an error in the measurement. In this case, we suggest moving the
cursors until your measurement is taken from a point near the base of the signal.

Al- | F2

4 4 4

8.8 kHz

12250° 1033V

Al- | F2

4 4 4

8.8 kHz

12250°

1053V

0.62V 5.9°

0.75Vv 4.8°

vpp | “pp

”',| COR _ ”'| COR

To adjust you sizing curves and remove the error messages, go the Calibration tab, and click
View Curves.

COR

Vmp

J

COR

] Select Calibration Point ] Select Calibration Point
D1-F2 - (ECT) i ] D1-F2 - (ECT) o
100.0 ] 100.0
- 820 > ~ 800
£ a0 | ¥ £ 600
o [
N 460 Iy, N 400
@ 280 > @ 200

10.0 <t 0.0

3000 3400 200 60.0 1000 1400 67 370 673 975 1278 1581
Phase (degree) Phase (degree!
Name Value (°) Name Value (%)
FBH-60  99.0 = FBH-60 990 B
4XxFBH-20 1400 _L‘ ’ 4xFBH-20 1400 i‘
7] =

IA Invalid

[ e | |
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The sizing curve window appears. Each sizing curve you asked Magnifi to create is listed in the
drop-down menu. If an invalid notification is present on the curve, it means that either you
haven’t entered the sizing points yet or that Magnifi Go failed to create the curve. To adjust the
sizing curve manually, enter the value in the table.

In the above example, the entered phase angle for the 40% defect is 300°, but the correct phase
angle for the 40% is 120°. The 40% defect has an 180° bias due to wrong measurement direction.
In this case, we can simply change the angle value from 300° to 120° in the table to fix the sizing
curve.

Note: To quickly remove or add an 180° bias to a flaw in your sizing curve, click the Invert button.

To validate the curves, bring the measurement cursor over one of the calibrated flaws in the
Lissajous and get an estimate of the depth (shown in the lower right corner). If the flaw size
does not appear, it means that you are not in a channel where a sizing curve was set.
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LANDMARK

The following section describes how to calibrate your landmarks.

Go to the Calibration tab and click the Landmark icon. Calibrate the landmarks shown in the
Landmarks window the same way you calibrated the sizing curve(s) points. You can use the
Land channel to do so. The positions of TS1 and TS2 are described in the Landmark window in
the Setup tab (TS2 is the far side tubesheet or the first one encountered by the probe while
pulling back; TS1is the near side tubesheet).

o Home Setup Calibration Layout Current View @ It 5] 42°c (@W)
A é
© 0O A 70 I2% 98 No Ad ‘ ‘

==
Null  Acquire | Systern Sizing Curves  Wiew Curves  Landmarks  Auto-Calibration | Save Cal As..

Pata 2 *g 1100V |f| i 110,00V |f” | Land ‘ ‘tm.oovl
] Calibration - o - — . 7 -

Landmark O, /,

' Exit
IRV 4 Y
| |\ Ts2

—_—
b
\-___'—_—
5.67V 3037
| s
[veo [ o0 [ | CoR |
| T
| i ‘ ‘| A1_,| FEA‘ ‘I 2597° |I040V‘|
. i
‘ '_,_"’_,_‘ ‘ ‘ Calibrate ‘ L;__ .
I
‘ Feset ‘ { \
_________ j,':-_ meeemmsammens fraceccsaceccanncennedieamccanaaaaaananany .
=== \\\
K| [V e
7.08V 224° ? % 4.
B Ve |
ISI/ > w | Vrnp‘| mp |J ‘ COR‘|
 Notification center
1t LT is) AT (me) |2 (mm) & (mm ) Y Lm (mm)|Speed (m/#
o ‘ 1077 | 1815 |107700] 1815 [ wa | 0.000 1 HiA > 002001 A @

Once the landmarks are calibrated properly the system should recognize them automatically.

Note that in order to calibrate the default Exit landmark, data including the probe exit at the
far end of the tube is needed.
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INSPECTION

TUBE LIST MANAGEMENT

For each acquisition, Magnifi Go can automatically save a file using the file name defined
previously in the Tube List section of this document. Select the Automatic File Recording option
found by clicking the Acquisition preferences button in the Data window. This option is selected
by default.

Acquisition preferences:

Automatic File Recording

0 total, 0 acquired

4| o]
Y.

Auto Create new file on Next

Automatic Next on Stop acquisition

CSRENAIAES

Keep re-scan files

M »

The list of tubes is also shown in the Data window.

Data *
Row | Col

» 001 001 E[]

» 002 001

» 003 001

» 004 001

4 total, 0 acquired

_+_ Hor
X Y
M »
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Tubes are added or removed by using the first line of buttons in this window.

It is common practice to rescan your calibration tube and balance it periodically. You can save
this new calibration tube data by adding a new tube in your tube list (e.g. 999 0071).
Alternatively, you can exit the acquisition mode, scan your tube, and click the Save Cal As...
button in the Calibration tab to save your data; then, you can go back to the acquisition mode
and continue your inspection, automatically saving the acquired tubes in your bundle.

Once a tube has been scanned, the play icon is replaced by a checkmark icon next to the tube
description.

You can rescan a tube by selecting its name in the list and clicking the Rescan button in the
Home tab.

A tube name can be changed by right-clicking its name and selecting the Rename option.

STANDARD ACQUISITION

The following section describes how to perform an inspection.

1. Access Acquisition Mode by clicking the Setup Mode button in the Home tab. Acquisition
Mode is activated when the Setup Mode button is not gray.

2. Plug the AC probe into the two Reddy AC 4-pin connectors.

3. Put the probe head in a clear area in your standard and balance the probe by clicking
the Null button in the Home tab or the physical target button on the Reddy AC.

4. Put the probe head outside the tube and start the acquisition by clicking the Acquire

button in the Home tab or press the physical Play/Stop button on the Reddy AC.

Pull the calibration tube.

When done, press the Stop button or physical Play/Stop button on the Reddy AC.

7. Repeat steps 4,5 and 6 for all tubes requiring inspection in your bundle.

o o

MANUAL SEQUENCE

An inspection can also be done with the manual sequence. This feature is based on landmarks
and can trigger the acquisition start/stop and data recording automatically. At least two (2)
landmarks are needed to use this feature. These landmarks can be set in the Landmark section
in the Setup ribbon.

To set the manual sequence:

1. Click the Manual Sequence button in the Setup tab.

2. If a warning message displays in this window, change the parameters until no warning
is shown. The system guides you through the different windows.

3. Click Settings...
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€}

8.

[::E Seq. . X o Manual Sequence Configuration

Sequence

Type: O None @ Landmark

Start Recording Landmark:  None

Launch

o

Target |Settings..

Q @ Start Recording Delay: 00s =
NDD Review
. Stop Acquisition Landmark: TS1
Pushing
. Pulling/Recording Stop Acquisition Delay: 05s :
‘ Waiting for Next
oo —r— Restart
Automatic recording
is enabled, please Type: O None O User Input @ Timer
disable it.
Disable Delay: 30s :
Automatic
Recording
Setup mode is I |
enabled, please | OK I Cancel ‘
disable it.

Disable Setup
Mode

Select Landmark in the Type section

In the drop-down menu choose the Landmark to start the data recording. If you keep
the default landmarks, you can select the Exit landmark that triggers when the probe
exits the tube when pushed.

You can enter a delay to start the acquisition after the first landmark is detected (Start
Recording Delay) and a delay to stop the acquisition when the last landmark is detected
(Stop Acquisition Delay).

Two options are available to restart the acquisition: The user can either push a button
or use a timer. Select the desired option in the Restart section.

Click OK.

To use the manual sequence:

1.

o

Access the Acquisition Mode by clicking the Setup Mode button in the Home tab. The
Acquisition Mode is activated when the Setup Mode button is not gray.

Plug the AC probe into the two Reddy AC 4-pin connectors.

Put the probe head in a clear area in your standard and balance the probe by clicking
the Null button in the Home tab or the physical target button on the Reddy AC.

Open the Sequence window by clicking the Manual Sequence button in the Setup tab.
Place your probe in the tube requiring inspection and click the Launch button. This starts
the data acquisition.

Push the probe through the tube. If set correctly, this triggers the landmark that starts
data recording.

Push the probe until it exits the tube. This triggers the last landmark detection that stops
the data recording.
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8. Acquisition restart:

a. If you selected User Input in the settings of the Manual Sequence Configuration,
the system waits for the user to enter information on the tube to restart the
acquisition. Click NDD or Review. This adds a tag to the inspected tube and
restarts the acquisition. Repeat steps 6, 7 and 8a for all the tubes requiring
inspection.

b. If you selected Timer in the settings of the Manual Sequence Configuration, a
countdown triggers after the last tube acquisition is taken. The acquisition starts
after this timer has elapsed. Repeat steps 6 and 7 for all the other tubes requiring
inspection in the bundle.

During your inspection, you may encounter some tubes that can’t be scanned completely. If
this is the case, you won't be able to catch the landmark that triggers the data recording at
the end of the tube. In this situation, you can click the Target button in the Sequence window
to start the data recording.
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FOOTSWITCHES

Footswitches can be used to gain inspection time by quickly triggering functions like start/stop
recording or tagging a file for review. They also offer an alternative to manual sequences for
bundles where it is not possible to push the probe out of the tubes to trigger the landmark that
automatically starts the acquisition.

To set the foot pedals:

1. Plug the Foot pedals cable into the 18-pin connector of the Reddy.

2. Click the I/O button in the Setup tab.
B instrument 170 (s

Digital Inputs

Action Activation
Inputl: [Probot sequence launch/rea '] [GH press ']
Input2  [Probot jog reverse = | [Link to toggle action -]
Input3: [Probotjogforward V] [Lmktotogglaa:tion V]
Input4: [Probotjog reverse '] [Lmktotoggle action ']
Input5:  [Probot jog forward = | [Link to toggle action -]

A\ | puts are available f they are assigned to « Remote Cantrol » in the instrument encader page settings. |

Qutputs
Enabling source

Alarm: Min. duration: |0 ms

DC output: | Manual

3. Inputs 1to 4 are linked to the foot pedals 1to 4 respectively.
4. For each input, select the desired action from the Action drop-down menu.
5. Select the activation mode with the Activation drop-down menu. You can either

activate the action by pressing on the foot pedal or by releasing it.
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REPORT

MAGNIFI R

Analyzing data can be done directly on the Reddy AC screen or with a desktop computer using
Magnifi R (readback). The latter can be used with larger or multiple screens.

To export your inspection on an USB key with the Reddy AC, click the Transfer Inspection button
located in the General tab of the Backstage.

Inspection
Froject Folder:  Default D .5
Transfer
Inspection: Default D Inspection
] Inspection Transfer
r Inspection Transfer
e Select the inspections you want to copy between the local and external drive.
Local Inspections Compaonents on External Orive
Project. | 5000planned - Project: | Default -
‘ Selact All ‘ ‘ Clear Al ‘ ‘ Selact All ‘ ‘ Clear Al ‘ ~ Refresh
Mame Mame
| Default @ | Default @
Import | ReddyAC data g
Export | ReddyAC setup g

Each Project/Inspection can be exported from the instrument (left) to the USB key (right) or
imported from the key to the instrument.

24|Page



INDICATIONS

The two Indication buttons in the lower corner of the Lissajous windows can be used to add an
entry to the report. These two buttons indicate the code associated with the defect being
entered. They do the same thing but can be set to different flaw types.

To add an indication to the data:

1. Select the defect signal in the Strip chart and adjust the cursor so that the signal in the
Lissajous includes only the defect signal.

2. Click the red triangle on the corner of the Indication button to select the type of defect
being entered.

3. Click the defect button to add an entry to the report.

| D1- | F2, 1 00° 12474V,
8.8 kHz ‘\
22,50V 58.4° \ 2% q
. |
Vep | PP | s q a
u COR
1135V
: : 2 CRK
D1-F1 17.6 kHz = A1-F1
DNT
= DSI
ERO

/ NDD
0BS

7V139.1° 2 ofp 4  0.81V 324,

Vpp Cor || vpp PIT
PLG
» 001001 v

Indications can also be added to a tube to indicate, for instance, that it has no flaw or that it

is plugged.
To add an indication to a tube:

1. Load the file.
2. Click the No Defect button in the Home tab or right-click the tube and set the feature

of the tube.
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Setup ' . ) Full ' Save Keep :
Mode Mull | Previous  Acqguire Data Mext Re-scan Extent Best Fit Center Setup | Setup Mo Defect Rewview .

> 002 o1 NI J

Read/Acquire

j Re-scan
» 004 ; Delete Del
Rename
\l Set Feature [ |™ |o0BS |
J 1™ | PG
=" |RST

REPORT TABLE

To access the list of detects entered:

1. Make sure that the Report option is selected in the Layout tab.

I Layout Current View £

3size | Data Report Notification Information Documentation Note

2. Click the Report ribbon at the bottom of the screen to make the list visible.

Zone |Row  |Col” |Code Size Side Ampl. (V) Angle()  ChanneliCscan  Ypos (mm) LMK Y pos Offset Y pos. (mr Yleng. (mm)  Comment
1 0 0 000 000 0 00 00 00 x

2 0 0 Q.00 Q.00 o 00 0.0 o0 x

A\ 2 new notifications  Informatior

Report entries can be modified by changing the value in the table. You can also delete an entry
be clicking the X next to it.

REPORT GENERATION

Magnifi Go can automatically generate a full report with the report table.
To generate this report:

1. Access Backstage by clicking the arrow on the upper left corner of the Frontstage.

2. Click the Generate Report button in the Report section of the General tab.

3. Choose your preferences and enter the required parameters. The # of tubes in
component is used to show the percentage of tubes in each category.
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/1] Generate Report

VIL Section Selection

=== Sections to Include in Report

Report Summary

m Generate Report

Report Summary

Configure the Summary Section

‘ Client - | |Edayf

Component Type v | \Bundle Eddyfi ‘ |X|
D Show Empty Cells ‘ L U 7
‘Compunent SN v | |<enter value> ‘ |X|
Instrument Settings
‘ Site - Eddyfi Quebec ‘ lZl
Component Information ‘ Service Provider < ‘ IX|
Picture: |:| |:| ‘Work Order v | |<enter value> ‘ |X|
Inspection Summary ‘Prooedure v | |<enter value> ‘ |X|

‘Calibralion Standard ~ | |<enter value= ‘ IZI

R [eoerpaa—r~ 3 1A

Date and Signature
Screen Captures

# of tubes in component

[fr—
Comment

| Clear ‘ ‘ Reset to Default| | Imporl| | Export ‘
‘ x Cancel ‘ ‘ J Finish |

‘xCancel | " Next |

4. Click Finish to generate the report.

This creates a PDF report that shows information like the list of indications in your bundle and
a report summary with a pie chart.

Analysis Report @ eddyﬁ Analysis Report @ eddyﬁ

Component Information Inspection Summary
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e =
e e
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T e -
o I .
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The report logo can be modified by clicking the Select Company Logo in the System tab of
Backstage.

System

Measurement Convention Measurement Units | - [

© ASME O Metnc
0°
System O ASME Inverted - + @ Imperial
360°
O EDF

Automatic Features

Preferences

General

G Allow to save setup in original location

Display

Reminder to save setup after acquisition if not saved yet

Analysis
Analy: 5
™ Preview.
Al
b ® 3 °
(" edd
Select
Company Logo
Shortcuts Date and Time
Keyboard... Wednesday, 20 February 2019 10:40:31 Change...

e ~

The report table file in the Inspection folder can also be imported into other reporting software
such as TubePro™.
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